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XML-Based Layouts

- Two ways to build Ul: XML vs. Java
- XML:

- Declarative user interface

- Intuitive (like HTML)

- Separation between view and programming logic
- Easy to use with GUI builders



+ XML tag <-> instance of Java class

<Button _
android: text="Touch me"

/>

Button butt = new Button(this);
butt.setText("Touch me");

- Use Java when the widgets are not known
at compile-time



Getting Started

- New Android Project
» XML file

- in "res/layout” directory

- Activity

- in onCreate: setContentView
- AndroidManifest.xml|



Class android.view.View

- The basic building block for Ul components

- All Ul components are direct or indirect

subclasses of View (e.g. TextView, Button,
LinearLayout, etc.)

- A View occupies a rectangular area on the

screen and is responsible for drawing and
event handling



Some Common View Properties
- android:id (int)

- Mandatory if the view is referenced by others
- 1d="@+1d/my_button"

- android:visibility (int)
- View.VISIBLE, View.INVISIBLE, View.GONE
. android:focusable (boolean)

- android:background (int)

- Background image

- Use @drawable/xxx to refer to
/res/drawable/xxx.png (or xxx.jpg, Xxx.9.png...)



- TextView

- Button

Basic Android Ul Components
25 Ml & 2:59 am

Your e-mail:

EditText

et e———

Please send me offers from

. RadioButton or FMI's tru...

- ImageView




- android:text, textSize, typeface, textColor

- android:gravity

- One or more (separated by '|') of the following: top
bottom left right center_vertical center

- android:minLines (also maxLines, minWidth ...)

- android:ellipsize

- android:autoLink

- hone web email phone map all
- Rich text support - use class SpannableString
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ImageView

- android:src (drawable id)

- android:scaleType

- Controls how the image should be resized or
moved to match the size of the ImageView

- fitCenter, fitStart, fitEnd, fitXY, center, centerCrop,
centerlnside, matrix

- getlmageMatrix(), setlmageMatrlx(Matrlx)




WebView

- Displays web pages

- WebView vs Browser application

- To access Internet, add INTERNET permission

in the manifest; <uses-permission
android:name="android.permission.INTERNET" />

- loadUrl("http://...")
- loadData("<html>...", "text/html", "utf-8:%
- goBack(), reload(), ...



Some More Views

- ProgressBar
- KeyboardView: a virtual keyboard
- SurfaceView: provides a dedicated drawing

surface embedded inside of a view hierarchy

- ViewStub: an invisible, zero-sized View that can

be used to lazily inflate layout resources at
runtime

- DatePicker, TimePicker; AnalogClock
- ToggleButton



Accessing Ul
Components From Code

To access the following view:
<TextVvView android:id="@+1d/myTextVview"

ce. />

write the following code:

TextView myTextvView = (TextView)
findviewById(R.1d.myTextView);



The gen/R. java File

- Contains reference identification numbers for all

resources in the res/ directory

- Use these numbers rather than the items on the

filesystem

* Int constants

- Auto-generated

- Nested classes: id, layout, string, drawable, ...

« No reason to modify it

- Can be ignored from version control (SVN, git...)



Handling User Interactions

- MVC

- Event Listeners:

- onClick(View v)

- onLongClick(View v)

- onFocusChange(View v, boolean hasFocus)
- onKey(View v, int keyCode, KeyEvent event)
- onTouch(View v, MotionEvent event)




Handling User Interactions - 2

- In Android 1.6 or later:

class MyActivity extends Activity {

public void myClickHandler(view target) {
// Do stuff

¥
}

<Button android:onClick="myClickHandler" />



Handling User Interactions - 3

- In all Android versions:

private onClickListener mMyButtonListener = new
onClickListener() {

public void onClick(view v) {
// do something when the button i1s clicked

}
};

protected void onCreate(Bundle savedvalues) {

Button button = _
(Button)findviewById(R.1d.myButton);
button.setonClickListener(mMyButtonListener);



View Groups

- Can contain other

views (called
children)

- Views are leaves and

ViewGroups are
internal nodes

- Composite design

pattern

‘ ViewGroup \
‘ ViewGroup \ ‘view\ ‘view\

‘ View \ ‘ View \ ‘ View \




Layout Parameters

- Used by views to tell their parents how they
want to be laid out

- android:layout_width, android:layout_height

- Describe how big the view wants to be

- Mandatory for any view inside of a containing
layout manager!

- Allowed values:

- wrap_content - just large enough to fit the view's
internal content, taking its own padding into account

- fill_parent (match_parent in APl Level 8) — as bigfasithe
parent, minus the parent's padding

- <exact number>



Layouts

- Subclasses of ViewGroup

- FramelLayout

- Children are drawn in a stack,
pegged to the top left of the screen

- ScrollView is a FramelLayout
- LinearLayout

- Arranges its children in a single
column or a single row

- RadioGroup is a LinearLayout
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Layouts - 2

- RelativelLayout

- The positions of the children can be described in
relation to each other or to the parent

- In child views: android:layout_toRightOf, etc.

- TableLayout

- Arranges its children into rows and columns
- Consists of a number of TableRow objects

- AbsolutelLayout - deprecated
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Adapter Views

Subclasses of ViewGroup
ListView - list of scrollable items
GridView - shows items

in 2D scrolling grid

Spinner - displays one child at a time
and lets the user pick among them

GaIIery - shows items in a
center-locked, horizontally scrolling list
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Adapters

- A bridge between an AdapterView and data
- Provides access to the data items

- Creates a View for each item in the data set
- myView.setAdapter(adapterInstance);
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- ArrayAdapter<T>

- By default: T[] -> TextViews using toString()
- Override getView to create more complex views

- SimpleCursorAdapter

- Maps columns from a cursor to TextViews or
ImageViews defined in an XML file
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Custom Adapters

- 1nt getCount();
- Object getItem(int position);

- View getview(int position,
View convertView, ViewGroup parent);

- convertView: it can be either null or some old view
that eventually can be reused

<Someview> result;
1f (convertview != null) {

result = (<Someview>) convertView; //reuse
} else { /*create new View*/ }

// setting result's properties, listeners,
return result;
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Menus

- Provide a familiar interface for the user to

access application functions and settings

. Useful for additional functionality since menus

don't occupy valuable screen space

- Base class: android.view.Menu

- Not related with the View class hierarchy
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Menu Types

1.0ptions Menu: appears when the user presses
the device MENU key

- lcon Menu

- maximum of 6 menu items

* menu items support icons and do not support
checkboxes or radio buttons

- Expanded Menu

- vertical list of menu items exposed by the "More" menu
item in the Icon Menu

« when the Icon Menu is full, the expanded menu s
comprised of the 6th menu item and the rest
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Menu Types - 2

2.Context Menu: appears on long press on a
View

3.Submenu:

- A floating list of menu items that the user opens
by pressing a menu item in the Options Menu or a
context menu

- [tems cannot support nested submenus
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Defining Menus

- res/menu/game_menu.xm|

<?xml version="1.0" encoding="utf-8"7>

<menu

xmlns:android="

android">
<item and
and

and

<1tem anc
and

anc
</menu>

roid
roic
roic
roic
roic

nttp://sc

:i1d="0+10
:7con="0@c

hemas .android.com/apk/res/

/new_game"
rawable/1c_new_game"

:title="@string/new_game" />

:1d="@+1d/q

uit”

:1con="0@c¢

roio

rawable/1c_quit"

:title="@string/quit” />
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Defining Menus - 2

- In the activity:

@verride

public boolean onCreateOptionsMenu(Menu menu) {
MenuInflater inflater = getMenuInflater();
inflater.inflate(R.menu.game_menu, menu);
return true;

}
- When the user opens the Options Menu for the first

time, Android calls onCreateOptionsMenu
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Defining Menus - 3

- Handling user operations

@verride _ _
public boolean onOptionsItemSelected(MenuItem 1tem) {
switch (1tem.getItemId()) {
case R.1d.new_game:
newGame () ;
return true;
case R.1d.quit:
quit();
return true;

default: _ _
) return super.onOptionsItemSelected(item);
¥

+ To change the menu when it opens -
onPrepareOptionsMenu()
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Defining Context Menus

» You can create a context menu for any View

- Call Activity.registerForContextMenu() and

pass it the View

- Override onCreateContextMenu() and

onContextltemSelected()
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Defining Submenus

<?xml version="1.0" encoding="utf-8"7>

<menu
xmlns:android="http://schemas.android.com/apk/res/

android'>
<item android:id="@+id/file"
android:icon="@drawable/file"
android:title="@string/fi1le" >
<l-- "file" submenu -->
<menu>
<item android:id="@+id/new"
android:title="@string/new" />
<item android:i1d="@+1d/open”
android:title="@string/open’ />

_ </menu>
</1tem>
</menu>
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Specifying Colors

» Directly: similar to HTML

- #RRGGBB, #AARRGGBB, #RGB, #ARGB
- Android predefined colors:

- @android:color/white
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Specifying Colors - 2

» Custom predefined colors:

- [res/values/<filename>.xml

<?xml version="1.0" encoding="utf-8"7>
<resources>
<color name="mywhite">#ffffff</color>
<color name="myblack">#000000</color>
</resources>

- Example:
android:textColor="@color/mywhite"
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Different Layouts
in Portrait and Landscape Mode

= E=

- /res/layout/<your-layout>.xml and
/res/layout-land/<your-1layout>.xml

- For drawables: /res/drawable and
/res/drawable-1land

- By default, onCreate is called on rotation
. Left Ctrl + F11 in emulator
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Styles

A collection of properties that specify the look
and format for a View or window

Similar to CSS

Separation between the design and the content

Instead of this:

<TextView _ _
android: layout_width="fill_parent”
android: layout_height="wrap_content”
android: typeface="monospace"
android:text="@string/hello" />

you can write this:

<TextView style="@style/CodeFont"
android: text="@string/hello" />
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Defining Styles

- res/values/<arbitrary_name>.xm]

<?xml version="1.0" encoding="utf-8"7>
<resources>
<style
name="CodeFont"
parent="@android:style/TextAppearance.Medium">
<1tem
name="android: lTayout_width">fi11_parent</item>
<1tem
name="android: layout_height">wrap_content</1tem>
<item name="android: typeface">monospace</1tem>
</style>
</resources>

- Several styles can be defined in a single file
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Applying Styles

<Textview style="@style/CodeFont"
android: text="@string/hello"” />
- The style attribute does not use the android:

namespace prefix

- If a style is applied to a ViewGroup, the child
View elements will not inherit the style
properties
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Style Inheritance

+ To inherit from built into Android style:

<style name="GreenText'
parent="@android:style/TextAppearance">

<1tem name="android:textColor">#00FF00</1tem>
</style>

- To inherit from styles that you've defined
yourself:

<style name="CodeFont.white">
<1tem name="android:textColor">#FFFFFF</1tem>*
</style>
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Themes

- A style applied to an entire Activity or

application, rather than an individual View

- Every View will apply each style property that it

supports

- Add android:theme attribute to the

<activity> or <application> element in the
Android manifest
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Notifying the User

- Toast Notification

- for brief messages that come
from the background

. Status Bar Notification

- for persistent reminders that

come from the background and

request the user's response
- Dialog Notification

- for Activity-related
notifications

a8:00™ ™
&2-2n4m -
This alarm Is set for 17 hours and 57
minutes from now.
9.00 .
25 April 2009 LAl @ 3:41pm
Android | Clear notifications |
E7 Travis

Where you at? 339 PM
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Localization

Do not use hardcoded strings

Place them in res/values/strings.xml:

<?xml version="1.0" encoding="utf-8"7>
<resources> _
<string name="'welcome">Welcome</string>
<string name="title">title</string>
</resources>

Use @string/title and getString(R.string.title)

Put localized strings in res/values-xx/strings.xml|
where xx is the ISO 639-1 language code

Example: values-el/strings.xml for Greek:

<resources> o _
<string name="'welcome">KxAwg npbuate</string>
<string name="title">TLTAOC</String>
</resources>
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Thank You!
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